Contents

ABOUT WINDSIM...................................................................................................................... 1
MICROSITING.............................................................................................................................. 1
MODULAR APPROACH .............................................................................................................. 1
WINDSIM MODULES................................................................................................................. 2
ABOUT THE TECHNOLOGY......................................................................................................... 2
WINDSIM EV VERSUS THE WINDSIM COMMERCIAL VERSION .............................................. 4
INSTALLATION ........................................................................................................................... 4

EXPLANATION OF CONTROLS & NOMENCLATURE ............................................................... 5

TITLE BAR................................................................................................................................. 5
MENU BAR ................................................................................................................................. 5
File............................................................................................................................................... 6
Layouts ....................................................................................................................................... 7
Modules ..................................................................................................................................... 7
3D Visualization ......................................................................................................................... 7
Tools .......................................................................................................................................... 8
Settings ..................................................................................................................................... 9
Help .......................................................................................................................................... 10

MODULE SELECTOR ................................................................................................................ 10

INFORMATION PAGES ........................................................................................................... 11
Description Pages ..................................................................................................................... 12
Report Pages ............................................................................................................................ 12
Start .......................................................................................................................................... 12

MODULE - PROGRESS ............................................................................................................ 12

PROPERTIES ........................................................................................................................... 13

PROCESSING OUTPUT .......................................................................................................... 14

TUTORIAL PROJECT: HUNDHAMMERFJELLET ........................................................................ 15

TERRAIN................................................................................................................................... 15

WIND FIELDS ............................................................................................................................ 24

OBJECTS .................................................................................................................................. 28

NOISE CALCULATIONS ........................................................................................................... 35

RESULTS .................................................................................................................................... 37

WIND RESOURCES .................................................................................................................. 41
Wake Modeling .......................................................................................................................... 43
About WindSim

**Micrositing**

WindSim is a modern Wind Farm Design Tool (WFDT). WindSim is used to optimize the wind farm energy production while at the same time keeping the turbine loads within acceptable limits. This is achieved by calculating numerical wind fields over a digitalized terrain. In the wind energy sector this is called micrositing.

By coupling the numerically calculated wind speeds and wind directions against available site-specific climate conditions the optimal position for each turbine can be found. Climate conditions are most frequently given by on-site measurements, but could alternatively be derived from meteorological models. WindSim can interface with both of these types of datasets.

The loads on a wind turbine are influenced by wind field characteristics such as; wind shear, inflow angle, and turbulence. Since the wind field modeling is 3D all of these characteristics are calculated and checked to be within acceptable limits for a given turbine type.

The optimization of the energy production and the minimization of the loads could be conflicting processes. The location yielding maximum energy production for a wind turbine could also yield too high loads, and often a compromise must be found: a location with the highest possible energy production still with acceptable loads. Micrositing is an iterative process where various turbine locations and types have to be inspected.

**Modular Approach**

WindSim uses a modular approach with six modules to complete the steps within micrositing.

![Figure 1 - WindSim is a modular based Wind Farm Design Tool (WFDT)](image)
About WindSim

A full micrositing will require execution of all six modules. The modules must be executed in the right order as there are dependencies between the modules. However, depending on the purpose of the project, it is not always necessary to run all the modules.

**WindSim Modules**

- **Terrain**
  Establish the numerical model based on height and roughness data
- **Wind Fields**
  Calculation of the numerical wind fields.
- **Objects**
  Place and process wind turbines and climatology data.
- **Results**
  Analyze the numerical wind fields.
- **Wind Resources**
  Couple the numerical wind fields with climatology data by statistical means to provide the wind resource map.
- **Energy**
  Couple the numerical wind fields with climatology data by statistical means to provide the Annual Energy Production (AEP); including wake losses. Determine the wind characteristics used for turbine loading.

In addition to the modules there are stand-alone *Tools* for data preparation and data post-processing. In particular, *Tools* are used for the import and preparation of terrain and climatology data. WindSim 8 also works with Add-on Modules including the Remote Sensing Correction Tool (RSCT) and Park Optimizer.

**About the Technology**

Computational Fluid Dynamics (CFD) is used to perform the wind field simulations in WindSim. CFD is a numerical method for solving the fundamental equations of fluid flow. CFD has become a very useful method within many industries. Accurate flow simulations are required within the automotive industry, oil and gas, and of course within the aerospace industry. In these industries CFD has become the standard method for flow calculations.

The fundamental behavior of fluid flow is described by the Navier-Stokes equations. The Navier-Stokes equations are non-linear partial differential equations known to be unstable and difficult to solve. Therefore simplified methods, where the troublesome non-linear terms have been linearized have become popular within the wind energy sector. However, the severe penalty is the reduced accuracy in the results.
The differences between the traditional so-called linear method and the CFD method could be illustrated by looking at speed-up over a ridge. The speed-up increases with increasing inclination angles until the flow separates, as seen in the upper part of Figure 2.

This behavior is captured by a CFD method. Even for smaller inclination angles, when the flow does not separate there is a significant difference in predicted speed-up between the linear and the CFD methods.

For an inclination angle above 20 degrees (Case C) the flow separates. The recirculation acts as an extension of the terrain, the ridge becomes more like a plateau and the speed-up is reduced.

The Navier-Stokes equation is time averaged introducing terms for the speed fluctuations. A turbulence model is required to close the equation set of the so-called Reynolds Averaged Navier-Stokes equation (RANS). The RANS equations are discretized in a computational domain, and integrated with a finite-volume procedure.

There are various solvers and solver strategies implemented in the software. Turbulence is taken into account using various types of two equation models like the \( k-\varepsilon \) model.

We invite you to learn more about the Bolund Experiment. The Bolund experiment is a field campaign that provides datasets for validating numerical models of flow in complex terrain and was the basis for a unique blind comparison of flow models. The CFD methods—including WindSim—showed the lowest errors among the various methods used. Find out more about the Bolund Experiment at windsim.com.

Figure 2 - Upstream speed-up, (Speed hill top/speed inlet). Average inclination angle (degrees) A) 5.7 B) 11.3 C) 21.8 - Linear model (light grey) CFD model (dark grey).
About WindSim

WindSim EV versus the WindSim Commercial Version

WindSim EV contains all the features of the commercial version but is intended for evaluation use. The only restriction of WindSim EV is the maximum number of cells used to discretize the computational domain. The total maximum numbers of cells are 5000, and there are 10 layers of cells vertically. The limit on the number of cells; as will be shown in the following paragraphs, have two effects:

- It smooths the features of the given height and roughness data
- It introduces significant discretization errors

The results obtained with WindSim EV are therefore not intended for commercial work. However, the user will be able to explore all the components of the software with this tutorial, and also appreciate the power of the commercial version.

Installation

Download WindSim EV from [http://www.windsim.com/download/evaluation.aspx](http://www.windsim.com/download/evaluation.aspx) and run the installation file. You may have already obtained the installation on a CD or on a USB key in a training session.

WindSim 8 requires the Microsoft .NET Framework 4.5. Please install it before you begin your WindSim installation if it is not already installed on your computer.

Get the Microsoft .NET Framework 4.5 here.

WindSim is by default installed on C:\Program Files\WindSim, while the project folder where WindSim projects are stored is located in the My Documents\WindSim Projects folder. You may change these default settings during the installation. After installation while running the program projects could be saved at arbitrary locations.

Once WindSim is installed it can be run from the shortcut added on the desktop or from the list of programs in the Start Menu of Windows.
Explanation of Controls & Nomenclature

The program consists of the following components:

- Title bar
- Menu bar
- Module selector
- Information pages
  - Description
  - Report
- Task list
- Properties
- Property information
- Processing output

**Title Bar**

The title bar consists of the following items:

- The WindSim logo
- Name of the program: WindSim
- Name of the current project
- Name of the current layout

![Figure 3 - Title bar.](image)

**Menu Bar**

The menu bar consists of the following items:

- File
- Layouts
- Modules
- 3D Visualization
- Tools
- Settings
- Help

![Figure 4 - Menu bar.](image)
Explanation of Controls & Nomenclature

File

Under the File drop-down menu, you will find all the controls needed for File management:

- New
  - Project
    - Create a new project
  - Project copy
    - Create a new copy of the current project
  - Layout copy
    - Create a new copy of the layout\(^1\) for the current project

- Open
  - Project
    - Open a project
  - Layout
    - Open a layout\(^1\) belonging to the current project

- Recent Projects
  - List of the recently used projects

- Remove
  - Project
    - Remove the current project
  - Layout
    - Remove the current layout belonging to the current project

- Print
  - Print the currently displayed page

- Print Preview
  - Preview the currently displayed page before printing

- Save
  - Save the current project

- Revert to saved
  - Reset the properties to the state before last module execution

- Open project folder
  - Opens location of the project folder

- Open report folder
  - Opens the location of the report folder

- Open program folder
  - Opens the folder where the program is installed

- Properties
  - Open a window with summarized main information on the current project

- Exit
  - Exit WindSim
Layout: when a project has more than one layout, the Terrain and Wind Fields will remain the same. Layout copy enables you to test different wind farm configurations using the same Terrain and Wind Fields data.

**Layouts**

Under the Layouts drop-down menu, the following commands are available:

- **Create copy**
  - create a new layout as a copy of the current one
- **List of loaded layouts**
  - tick off the layout you want to activate
- **Terrain texture file**
  - **Open**
    - Load a .bmp or .rgb texture to paste over the terrain
  - **List of loaded textures**
    - tick off the texture you want to activate

**Modules**

Under the Modules drop-down menu, the user can choose which module to run. The functionality of each module is described in more depth later in this document. The present drop-down menu is equivalent to the Module Selector:

- **Terrain**
- **Wind Fields**
- **Objects**
- **Results**
- **Wind Resources**
- **Energy**

**3D Visualization**

In this module the user can select several 3D Visualization items:

- **Generate 3D wind visualization file (*.vtf)**
  - Generate a wind visualization file
- **Open 3D wind visualization file (*.vtf)**
  - Open an existing wind visualization file
- **Download 3D samples …**
  - Download .vtf files from the WindSim website.
- **Download sky textures …**
  - Download sky background examples from the WindSim website.

The .vtf files can be opened with GLview PRO the application for post-processing provided with the full installation of WindSim or with GLview Express. GLview Express is a freely available viewer of .vtf files that can be downloaded from the WindSim website. GLview
Express contains a subset of the features of GLview Pro. It would be a tool for non-WindSim users to explore the 3D wind visualization results.

**Tools**

- View terrain model (*.gws)… View the terrain model in a text editor
- Import terrain model (*.gws)… Import a terrain model to WindSim
- Convert terrain model… Convert terrain data from .map format to the WindSim format .gws
- Terrain Editor… Launch the Terrain Editor application
- Find forest parameters Launch Excel sheets for the calculation of forest parameters
- Advanced conversion :
  - Convert terrain model (CMD) Convert terrain data from other formats to the WindSim terrain format, *.gws
  - Convert climatology data (CMD) Convert climatology data from other formats to the WindSim format .wws
- Import mesoscale driving data (*.dws)… Import results from a meteorological model
- View climatology data (*.wws)… View the climatology file in a text editor
- Convert climatology data… Convert climatology data from the .tab format to the WindSim format .wws
- Create power curve (*.pws)… Create the power curve file of the considered wind turbines if they are not present in the WindSim database
- Import objects (*.ows)… Import objects into WindSim from an *.ows file
- Export object (*.ows)… Export objects in the current layout to an .ows file
- Losses and Uncertainties... Calculation of losses and uncertainties
- Flow Model Validator Validation of simulated vertical profiles against measured profiles
- Forecasting... Launches the Add-on Module WS Power Forecasting
- Power Line Launches the plug-in to calculate transmission line capacity
- MCP
  Launches the plug-in to do MCP
- Reanalysis Data Downloader
  Launches the plug-in to download MERRA mesoscale date
- Queue
  Launches the plug-in to run several projects automatically
- Park Optimizer …
  Launch the Add-on Module WS Park Optimizer
- Remote Sensing Correction Tool...
  Launch the Add-on Module WS Remote Sensing Correction Tool, used to correct LIDAR data based on WindSim results

Export

- Export climatology data (*.tab)…
  Export a climatology file to the .tab format
- Export object (*.ows)…
  Export objects in the current layout to an .ows file
- Export to Google Earth(.kml)
  Export report maps to Google Earth
- Create Word report...
  Generate a report of your project in .doc format
- Export HTML report...
  Generate a report of your project in HTML format
- Export vertical profiles…
  Extract vertical profiles of chosen scalar at turbine and/or climatology positions
- Export WindPRO flowres file…
  Exports the results from the windfield module to a WindPRO readable format
- Export OpenWind WRB file…
  Exports the results from the windfield module to a OpenWind readable format
- Export Lookup Tables
  Creates tables for wind power forecasts

Settings

In the Settings section you will find:
- Validation Program
  Share your cross-check results
- Renew Key
  Renew your hard ware key
Explanation of Controls & Nomenclature

- Advanced Settings
  - Choose the output file type asci or binary
- Change language
  - Change the current language
- Limits
  - Click to see the computational limits of WindSim models

Help

In the Help section you will find:

- About WindSim
  - Version and License information.
- Release Notes
  - Links to web-based version of the Release Notes. RSS-enabled.
- Manuals
  - “Getting Started”, MCP, Queuing, reanalysis downloader descriptions
    * License codes are not required for WindSim EV, our evaluation version.

Module Selector

The Module Selector, shown in Figure 5, consists of the following headings:

- Terrain
- Wind Fields
- Objects
- Results
- Wind Resources
- Energy

* Figure 5 - Module selector with the Terrain module activated.

Click on a module button to activate it.

Your progress with WindSim's modular approach is always visible. Once selected, a Module button can have one of three states:

- Modules with a green check have been run successfully.
- Modules highlighted with animated circular arrows are running.
- Modules with a grey cross have not been run.

NOTE: There are important dependencies among the modules.
You must first run the *Terrain module* in order to establish the computational model to successively generate the wind database. When the *Terrain module* has a green check, you can run the next module, the *Wind Fields module*.

In the *Wind Fields module* the wind database is generated. This database contains detailed information about the wind field in the computational model established in the *Terrain module*. If the user now go back to the *Terrain module* and change any of the parameters, the *Terrain module* will become red. It needs to be re-run to be updated, and the same procedure must be done with the *Wind Fields module*. It does no longer contain a wind database that is compatible with the terrain model the user re-defined in the *Terrain module*. Once the user has calculated the terrain model and the wind database the *Terrain and Wind Fields modules* will have green checks, then you may start working with the other modules.

The *Objects module* will place and process climatology data and place wind turbines. They are commonly called “objects”. Both climatology and wind turbine objects must be specified in the *Objects module* in order to process all the remaining modules.

The wind data are visualized in the *Results module*. Both the *Terrain and Wind Field modules* must be correctly run before you can run *Results*.

The wind measurements contained in the climatology files are then used to weight the wind database. This is done in order to get realistic data about how the wind is influenced by the terrain in the *Wind Resources module*.

The wind turbines locations and power curves loaded in the *Objects module* are combined with wind measurements in the *Energy module*, to compute a complete estimation of the energy production.

The best way to get a good feel for these dependencies is to start working with WindSim.

Please refer to the example project described later in this document for further guidance.

**Information Pages**

There are *Description* and *Report* pages in all WindSim modules. By clicking on either of the links you are able to toggle between the corresponding pages. The active link is colored blue. In the *Objects module* there is one additional link to activate the *Park layout*. Whenever the information pages contain sub-pages the toggles *Back* and *Forward* are used for browsing.
Description Pages

The description pages describe the purpose of a module. It explains which consideration you need to make in order to successfully run the module. The Description pages also give a detailed explanation of the Properties, which is the module input. The Description page header displays the module name, the WindSim version number, and the date when the pages were last updated.

Report Pages

The report pages contain the results from the corresponding module. The Report page header contains information about the project. There is information about the License, Customer, Project, Layout, WindSim version number, and a timestamp when the report was generated.

Start

Each module is run by clicking on the Start button. The Task List appears above it showing if the module is ready to be started or if a previous dependent module has to be started first.

Module - Progress

Figure 6 - Information pages.

Figure 7 - Description page header.

Figure 8 - Report page header.

Figure 9 - Start button

Figure 10 – The WindSim Module Selector displays your progress through the modules.
Your progress with WindSim’s modular approach is always visible. Once selected, a Module button can have one of three states:

- Modules with a green check have been run successfully.
- Modules highlighted with animated circular arrows are running.
- Modules with a grey cross have not been run.

**Properties**

In the *Properties panel* located on the right hand side of the screen, all the settings for a given project are specified. Each module has its own set of properties. Explanations of the properties are found on the *Description pages*. You can click on the property to insert and type the desired values. You can also use the arrow keys to move up and down through a list of options provided to make a selection. Whenever you need to specify more than one value for a property, the semicolons syntax is used to separate the values. Press the *Enter key* when ready to enter a new value or click somewhere outside the current input field in order to set a new value.

The frame below the *Properties panel* shortcut information about the selected property is given.

**NOTE:** More detailed information about each property is found in the *Description page* of the current module.
Explanation of Controls & Nomenclature

Properties

Figure 11 - Properties for the Terrain module including property information of the selected property (roughness height) in the lower frame

Processing Output

In this frame you will see the output result concerning the module which is currently running or just finished. This result may contain information describing if the module has been run correctly. Otherwise it will display errors, warnings, or additional information.

Figure 12 - Processing output frame.
Tutorial Project: Hundhammerfjellet

In this tutorial project we look at the site of Hundhammerfjellet, located on the coast of Norway. The tutorial will guide you through all six modules of WindSim.

Open WindSim and start a new project by choosing:

File > New > Project...

The New Project window is opened;

![New Project window](image)

Figure 13 - New Project window.

Set your project location, which is the folder where your project will be stored, by browsing your hard drive, push the button or use the default path, (C:\Documents and Settings\User_name\My Documents\WindSim Projects), give a project name, leave the Layout name as Layout 1, and finally enter the name of your customer. If no GWS file is specified, then the grid.gws with the terrain from Hundhammerfjellet will be automatically copied from the WindSim installation area. In this tutorial, this field is kept empty to load to default terrain data. Elevation and Roughness data are read from the .gws file, and imported in the new WindSim project. Click OK in order to create the project.

**Terrain**

The first step within micrositing is the generation of a 3D model in the Terrain module. This involves choosing the horizontal and vertical extension of the volume to simulate. This volume, which we will call the **computational domain**, is then discretized into a system of
hexahedral cells called a grid or mesh. The computational domain is built based on the digital terrain in *.gws format containing information about elevation and roughness.

WindSim can be run either by using the default settings in Properties or by specifying their own settings.

**NOTE**: *If you specify a non-default property value, then it is shown in bold type.*

In WindSim EV, the maximum number of cells in the vertical direction has been set to 10, while the total number of cells in all three directions has been limited to maximum 5000. In the commercial version of WindSim, the maximum number of cells would typically be limited by the available computer resources. Models with millions of cells can be simulated on PCs with a 64-bit operating system. The restrictive limitation in WindSim EV on the number of cells used for the computational model means that the results will not have the accuracy required for a proper micrositing thus WindSim EV it is not intended for commercial work.

Run the **Terrain module** by clicking on the **Start** button with the below settings;

![Property settings for the Terrain module.](image)

Upon successful completion, the Module Selector of the **Terrain module** will have a green check and the Description pages will automatically be switched to the Report pages. Some of the content in the report are presented below.
Click on the black arrows above the plots in the Report pages to visualize various 2D field data:

- Elevation
- Roughness height ($z_0$) with both linear and logarithmic scale
- Inclination angle (deg)
- Second order derivative of the elevation
- Delta elevation.

  The delta elevation variable gets a non-zero value only when the smoothing option is applied to the model.

Click on 3D Model and the black arrows to visualize:

- Grid (xy)
- Grid (z)
- Open area
Grid (xy) and Grid (z) contain information about the grid spacing and number of cells used for the discretization in horizontal and vertical directions.

The Open area data is a useful tool to understand if too much blockage has been introduced in the generation of the 3D model. A Wind Field simulation can be viewed as a numerical wind tunnel test; too much blockage would produce unphysical and therefore unacceptable speed-ups. The ratio between minimum and maximum open area is used in the automatic generation of the proper height of the 3D model, see the Description pages for details.

When you click on 3D at the upper right of each plot; a 3D model in the visualization tool GLview is opened. The 3D visualization option is available for all the sections 2D Fields, 3D Model, and Extension. The 3D visualization option is also available in the other modules of WindSim.

There is a separate section in this document that further explores GLview. For now, we only explain the basic operations of movement:

- Translation with left mouse button
- Rotation with right mouse button
- Zoom with mouse wheel or both mouse buttons simultaneously

Click on Extension to visualize the horizontal extension of the generated 3D model which is marked with a grey frame over an elevation contours map;
The contour map for the Extension is based on the original resolution of the .gws file, thus on the maximum possible resolution and not on the 3D model which is coarser than the original digital terrain data. The difference in resolution is particularly clear when comparing the two plots under 2D Field: Elevation and Extension.

If you want to reduce the extension of the model, it is possible to explore the terrain extension in the 3D model, where the needed coordinates are found. In order to produce a finer mesh, which means smaller discretization errors in the area of interest where the wind park has to be constructed, a new terrain model is therefore desired with user specified properties.

Assign a new extension to the terrain model in the Properties panel by new X-range and Y-range. Define a refinement area to design an even denser grid in the area of interest, where the wind park has to be located;
In this way you have cropped from the original .gws file an area only covering the ridge of Hundhammerfjellet, where the wind park will be located. The borders of the computational domain are still quite far from the area of interest in order to avoid too heavy boundary effects.

Click “Start” on the right hand side of your screen to run the Terrain module again.

Click on **Terrain > Report > Extension** to get the Figure 18 and Figure 19 in the Report frame, which shows the extension of the new 3D model compared to the original gws terrain data.

**NOTE:** When refinement is applied, the horizontal resolution varies. Its minimum and maximum values are available in the **Report > 3D Model** and **Grid (xy)**.
Click on **Terrain > Report > 3D Model**, and then select **Grid (xy)** using the black arrows to obtain the report on the horizontal discretization of the generated 3D Model shown in Figure 20.

Click on **Terrain > Report > 3D Model** and then select **Grid (z)** using the black arrows to obtain the report on the vertical discretization of the generated 3D Model, shown in Figure 21.

Click on **Terrain > Report > 3D Model**. Then select **Open area** by using the black arrows to obtain what is shown in Figure 22. The criteria named **Open area** account for the ratio of minimum and maximum area of the intersections of the computational domain with vertical planes south-north and west-east directed. The wind field simulations can be seen as numerical wind tunnel “runs”. So, it is important to reduce the blockage effect which produces unphysical speed-up.

**NOTE:** The ideal height of the 3D model is computed automatically in order to keep this ratio above an acceptable value, see Description for details.

*Figure 18 - The digital terrain model, marked as a box, is extracted from grid.gws.*
<table>
<thead>
<tr>
<th>x-min</th>
<th>x-max</th>
<th>y-min</th>
<th>y-max</th>
<th>x-extent</th>
<th>y-extent</th>
<th>resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>322950.0</td>
<td>332000.0</td>
<td>7182475.0</td>
<td>7190025.0</td>
<td>9050.0</td>
<td>7550.0</td>
<td>Variable</td>
</tr>
</tbody>
</table>

*Table 1. Digital terrain model.*

<table>
<thead>
<tr>
<th>x-min</th>
<th>x-max</th>
<th>y-min</th>
<th>y-max</th>
<th>x-extent</th>
<th>y-extent</th>
<th>resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>318000.0</td>
<td>332975.0</td>
<td>7180000.0</td>
<td>7194975.0</td>
<td>14975.0</td>
<td>14975.0</td>
<td>25.0</td>
</tr>
</tbody>
</table>

*Table 2. Data in grid.gws*

**Figure 19 - Terrain > Report > Extension.**

**Figure 20 - Terrain > Report > 3D Model: Grid (xy).**

**Fig 1. Digital terrain model - Grid (xy).**

Body fitted co-ordinates (BFC) are used in grid generation. The above plot displays the resolution at ground level.

<table>
<thead>
<tr>
<th>x</th>
<th>y</th>
<th>z</th>
<th>total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid spacing, min - max (m)</td>
<td>251.5 - 954.9</td>
<td>209.8 - 796.6</td>
<td>Variable</td>
</tr>
<tr>
<td>Number of cells</td>
<td>22</td>
<td>22</td>
<td>10</td>
</tr>
</tbody>
</table>

*Table 1. Grid data.*
Fig 1. Digital terrain model - Grid (z).

The grid extends 955.2 (m) above the point in the terrain with the highest elevation. The grid is refined towards the ground. The left and right columns display a schematic view of the distribution at the position with maximum and minimum elevation respectively. The nodes, where results from the simulations are available, are situated in the cell centers indicated by dots.

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>z-dist. max (m)</td>
<td>8.7</td>
<td>34.8</td>
<td>78.4</td>
<td>139.3</td>
<td>217.7</td>
<td>313.5</td>
<td>426.7</td>
<td>557.4</td>
<td>705.4</td>
<td>870.9</td>
</tr>
<tr>
<td>z-dist. min (m)</td>
<td>10.7</td>
<td>42.8</td>
<td>96.2</td>
<td>171.0</td>
<td>267.2</td>
<td>384.8</td>
<td>523.8</td>
<td>684.1</td>
<td>866.8</td>
<td>1068.9</td>
</tr>
</tbody>
</table>

Table 1. Distribution of the first 10 nodes in z-direction, relative to the ground, at the position with maximum and minimum elevation.

Figure 21 - Terrain > Report > 3D Model: Grid (z).
Wind Fields

Once the generation of the 3D model has been completed in the Terrain module, the CFD simulations of the wind fields can start. The wind fields are determined by solving the Reynolds Averaged Navier-Stokes equations (RANS). The standard k-ε model is one option for turbulence closure. The RANS equations are discretized and integrated with a finite-volume method. Starting with the initial conditions, which are guessed estimates, the solution is progressively resolved by iteration until a converged solution is achieved.

There are four possible ways to solve the RANS equations in WindSim:

- Segregated, a segregated solver (SIMPLEST)
  Robust but slow. Best for smaller projects 2-3 million cells
- Parallel segregated solver
  Similar to the segregated solver but single sectors can be split
- GCV; a General Collocated Velocity method. Very robust. Always delivers a converged solution
- Parallel GCV, a parallel solver of GCV to split single sectors.
For more information concerning the solver you can look at the “Description” in Wind Fields module.

Select the Wind Fields module, and run the module with default settings. A window will pop up to let you follow the development of the flow field during the iterative computation. If several sectors are solved simultaneously on different processors then one GLview window will open for each sector being solved:

![Figure 23 - One GLview window will pop up for each simultaneous sector being run.](image)

By default, the software monitors the magnitude of the velocity vector at the ground level (at the center of the ground adjacent cells). If the simulations have reached a converged solution, you should not be able to see any further change in this plot.

In the Report pages you can check whether the modeling has been carried out correctly, by inspecting the graphs of the Spot and Residual values for all the solved variables. This is shown in Figure 24 and Figure 25.
The report pages for the Spot and Residual values are completed with three tables regarding setting and status of the performed calculations.

In the Table 1 on the following page there is a summary of Boundary and Initial Conditions adopted for the simulations; Table 2 reports the Calculation parameters and the current status of the simulations while the Table 3 provides further information about Physical models and output for the wind field simulations. The parameters summarized in these tables are all explained in the description pages of the Wind Field module.
In the Wind Fields > Report > Field Value menu, it is also possible to see an animation of the development of the chosen variable during the iterative process. In well converged simulations, the calculated variables should not change any further with iterations. A screenshot of the monitored variable is shown in Figure 27.
Objects

The *Objects module* is used to:

- Place turbines in the park area
- Process climatologies
- Place transferred climatologies

Geometrical objects can also be placed within the 3D terrain model for visualization purposes. At the actual Hundhammerfjellet site there are 17 turbines and 2 climatologies. This layout is already established. It can be read by using the command:

*Tools > Import objects (.ows)*...

Load the file:

*C:\Program Files\WindSim\WindSim 10.0.0\Data\Objects\Hundhammer.ows*
Note that the name "Program Files" might vary according to which operating system you run on your computer.

17 wind turbines will be added to the park layout. The following window message will pop-up if the import is successful:

![Import succeeded](image)

*Figure 28 - Successful import of objects from an .ows file.*

An alternative to the procedure described is to introduce new objects interactively in the Park Layout of the objects module using the Toolbox on the right hand side:

![Toolbox](image)

*Figure 29 - Toolbox for interactive manipulation of objects.*

with the following tools:

- Select mode
- Add turbine mode
- Add climatology from file
- Add transferred climatology mode
- Remove selected object
- Remove all

With the Park Layout it is possible to add, drag and drop wind turbines in a graphical window. This helps the user to design the park layout and make modifications to it. After adding a
turbine it could be moved interactively. Change the position of an object by first activating the "Select mode" in the Toolbox. Next, select an object by the clicking the left mouse button, the objects is moved with the mouse while pressing the Shift button.

The user still needs to load the climatology files (.wws or .tws), before running the module. Load a climatology using the "Add climatology from file" from the Toolbox. Two climatologies have been prepared for the site at Hundhammerfjellet namely: 0150-Tommerholm-30m_1year.wws and 0801-Hundhammer-30m_1year.wws located under the folder: C:\Program Files\WindSim\WindSim 10.0.0\Data\Objects\Climatology. Both sets of data are for anemometers at 30 meters height, and referred to the same measuring period of 1 year. By using the "Add climatology from file" these climatologies are copied into the project folder structure.

Remark that climatology objects can't be moved, their position is given in the .wws or .tws files. The only way to change the location for a climatology object is to change the coordinates in the files.

The Objects module is now ready to run, click on the Start button. The layout of the wind farm can be visualized by selecting the Report > Object representation menu. The report for the Objects module will appear as in Figure 30 and Figure 31. The main features of the climatologies and turbines within the wind farm are listed in the tables 1 and 2 of the report.

Further information on climatologies and turbines are given if the user clicks on the links (blue bold type) in the tables. An animation is available which is activated by Report > Animation and 3D to open GLview Pro. An animation is also available directly in the Park layout.
Figure 30 - Objects > Report > Object representation.

Table 1. Climatology objects.

<table>
<thead>
<tr>
<th>name</th>
<th>x</th>
<th>y</th>
<th>z</th>
<th>hub height</th>
<th>turbine type</th>
</tr>
</thead>
<tbody>
<tr>
<td>0150-Tommerhol...</td>
<td>325917.0</td>
<td>7185790.0</td>
<td>126.1</td>
<td>30.0</td>
<td>Vestas V90 mod..</td>
</tr>
<tr>
<td>0801-Hundhamme...</td>
<td>327362.0</td>
<td>7186191.0</td>
<td>207.7</td>
<td>30.0</td>
<td>Vestas V90 mod..</td>
</tr>
</tbody>
</table>

The wind turbine characteristics combined with the calculated speed-ups constitute the basis for the energy calculations.

Table 2. Turbine objects.

<table>
<thead>
<tr>
<th>name</th>
<th>x</th>
<th>y</th>
<th>z</th>
<th>hub height</th>
<th>turbine type</th>
</tr>
</thead>
<tbody>
<tr>
<td>wecs3</td>
<td>326230.0</td>
<td>7186122.0</td>
<td>130.4</td>
<td>80.0</td>
<td>Vestas V90 mod..</td>
</tr>
<tr>
<td>wecs4</td>
<td>326564.0</td>
<td>7185983.0</td>
<td>129.8</td>
<td>80.0</td>
<td>Vestas V90 mod..</td>
</tr>
<tr>
<td>wecs5</td>
<td>326803.0</td>
<td>7185965.0</td>
<td>141.6</td>
<td>80.0</td>
<td>Vestas V90 mod..</td>
</tr>
<tr>
<td>wecs6</td>
<td>327057.0</td>
<td>7185983.0</td>
<td>158.3</td>
<td>80.0</td>
<td>Vestas V90 mod..</td>
</tr>
<tr>
<td>wecs7</td>
<td>327305.0</td>
<td>7185982.0</td>
<td>164.3</td>
<td>80.0</td>
<td>Vestas V90 mod..</td>
</tr>
<tr>
<td>wecs8</td>
<td>327505.0</td>
<td>7186159.0</td>
<td>201.5</td>
<td>80.0</td>
<td>Vestas V90 mod..</td>
</tr>
<tr>
<td>wecs9</td>
<td>327705.0</td>
<td>7186322.0</td>
<td>203.8</td>
<td>80.0</td>
<td>Vestas V90 mod..</td>
</tr>
<tr>
<td>wecs10</td>
<td>327932.0</td>
<td>7186491.0</td>
<td>180.3</td>
<td>80.0</td>
<td>Vestas V90 mod..</td>
</tr>
<tr>
<td>wecs11</td>
<td>328232.0</td>
<td>7186583.0</td>
<td>156.2</td>
<td>80.0</td>
<td>Vestas V90 mod..</td>
</tr>
<tr>
<td>wecs12</td>
<td>328387.0</td>
<td>7186747.0</td>
<td>165.8</td>
<td>80.0</td>
<td>Vestas V90 mod..</td>
</tr>
</tbody>
</table>

Figure 31 - Objects > Report > Object representation continued
Tutorial Project: Hundhammerfjellet

A photo or texture can be pasted on the terrain to provide a more realistic view of the wind farm area. Load the file `hundhammerfjellet.bmp` by opening `Layouts > Terrain texture file > Open ....` The file is located under the folder: `C:\Program Files\WindSim\WindSim 10.0.0\Data\Texture`. Run the object module again in order to apply the texture. Activation of Texture in the Objects module report gives a plot with the photo draped over the terrain as seen in figure 32.

![Figure 32 - Objects > Report > Object representation with Texture.](image)

Click on **3D objects** and open this graphic in GLview by clicking the **3D** button. This allows various perspective views of the wind farm. At this stage fly-troughs could be generated, check out the 3D Samples at the WindSim web site.
It is also possible to set up and display various cutting planes and iso surfaces. This is done by first clicking on the “Park layout” frame and then selecting the “Surfaces” tab. Finally, choose the sector from which to plot data, from the “Select sector” drop-down menu. The following tools will be lightened:

- Select mode
- Add terrain cut plane
- Add cutting plane
- Add iso surface
- Add swept area
- Remove selected object
- Remove all

**Add terrain cut plane**

With the “Add terrain cut plane” icon you can add a terrain parallel to the original. After you adjust the height of the plane you can choose the variable of interest from the “scalar” drop-down menu.
Add cutting plane

With the “Add cutting plane” icon you can add a plane to the original terrain. You can adjust both the position and the angle of the plane with the “Position” and “Normal” options.

Add iso surface

The “Add iso surface” icon displays an iso surface of a variable which you can select from the “Scalar” drop-down menu. The scale value of that variable will automatically appear on the left of the screen, but you can also choose display multiple scales from the “Map Value” drop-down menu. Furthermore, you can either choose the value of the variable by adjusting the value bar, or by selecting a specific one.

Add swept area

You can display the value of a variable on a wind turbine’s swept area by selecting a wind turbine with the “Select mode” and then clicking on the “Add swept area” icon.

Remove selected object & Remove all

You can always delete an object by choosing it and then clicking on the “Remove selected plane” icon. If you want all the objects deleted, then you can just click on the “Remove all” icon.

NOTE: This actions do not require confirmation, so be careful when you are about to use them.
The wind profile can easily be illustrated over the swept areas of the turbines as explained at the “Add swept area” node.

**Noise Calculations**

Noise calculations are performed in the Objects module. First, select a wind turbine or a climatology and then select **Noise calculation>Based on broadband** at the “Objects frame”, as shown in Figure 36, in order to carry out a noise analysis, which can be output at any height, for any wind direction and for any wind speed. The default settings produces a
noise map in 2 meters' height, for a northern wind of 5 m/s. The wind direction and wind speed is by default defined to be the conditions at the Hundhammer climatology.

<table>
<thead>
<tr>
<th>1: Object definition</th>
<th>2: Position</th>
<th>3: Noise calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Noise calculation</td>
<td>Based on broadband</td>
<td></td>
</tr>
<tr>
<td>Noise map height</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Background noise</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Attenuation coefficient</td>
<td>0.005</td>
<td></td>
</tr>
<tr>
<td>Noise at height</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>Noise coordinate system</td>
<td>Global</td>
<td></td>
</tr>
<tr>
<td>Conditions X position</td>
<td>327475</td>
<td></td>
</tr>
<tr>
<td>Conditions Y position</td>
<td>7186250</td>
<td></td>
</tr>
<tr>
<td>Noise at wind speed</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Noise at wind direction</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

*Figure 36 - Example Properties for the CFD noise calculations in the Objects Module*

Background noise level is set to 0 db so that only the noise contribution from the wind turbines is estimated. Local standards or project requirements may require the background noise to be included. The attenuation coefficient represents the industry standard for broadband noise. More experienced users might wish to adjust this constant to account for site specific atmospheric conditions and/or to account for an octave band analysis.

Run the *Object module* again by clicking the *Start* button.

A new set of reports is generated with a separate noise map found under *Report > Object representation > Noise*. The map represents the noise pressure level in dB for all locations in the project.
1. Figure 37 - Noise Calculation report

Results

In the Results module the user can extract 2D planes with variables stored in the wind database. The vertical extension covered is from the ground and up to the "Height of reduced wind database" as specified in the Wind Fields module. The 2D plane is given at a specified height above the terrain. The following variables and derived variables from the wind database are available:

- **Speed scalar X**: Wind speed scalar in the East-West direction, UCRT
- **Speed scalar Y**: Wind speed scalar in the North-South direction, VCRT
- **Speed scalar Z**: Wind speed scalar in the vertical direction, WCRT
- **Speed scalar XY**: Wind speed scalar in 2D = \( \sqrt{(UCRT^2 + VCRT^2)} \)
- **Speed scalar XYZ**: Wind speed scalar in 3D = \( \sqrt{(UCRT^2 + VCRT^2 + WCRT^2)} \)
- **Velocity vector XY**: Wind speed vector in the horizontal plane, \((UCRT, VCRT, 0)\)
- **Velocity vector XYZ**: Wind speed vector in 3D space, \((UCRT, VCRT, WCRT)\)
- **Direction scalar**: Wind direction in the horizontal plane in degrees
Tutorial Project: Hundhammerfjellet

Direction scalar relative
Wind direction in the horizontal plane relative to the incoming wind direction (degrees)

Turbulent kinetic energy
The turbulent kinetic energy \( KE = \frac{m^2}{s^2} \)

Turbulent intensity
The turbulent intensity assuming isotropic turbulence
\[
100 \times \sqrt{\frac{\frac{4}{3}KE}{\sqrt{(U_{CRT}^2 + V_{CRT}^2)}}} \quad (\%) 
\]

Turbulent dissipation rate
The turbulent dissipation rate \( EP = \frac{m^2}{s^3} \)

Pressure
The relative pressure minus hydrostatic term (Pa), the relative pressure has a value equals to zero at the outlet of the domain

Inflow angle
Angle between the wind vector and the horizontal plane

Wind shear exponent
Exponent alpha of the equation \( \frac{\text{speed}_1}{\text{speed}_2} = \left(\frac{\text{height}_1}{\text{height}_2}\right)^{\alpha} \) (-)

As an example the Wind velocity 3D (u,v,w), at 50 m height, and the Turbulent Kinetic energy at 50 m height is extracted. Remember to press New every time a new set should be activated. There is a limit of 200 plots that could be generated during one run. In the below case 2 variables x 12 sectors x 1 height will give 24 plots. Re-run the module if the 200 plot limit impose a restriction on your exploration of the various datasets.

1. Click New at the “Properties” window.
2. Choose “Velocity vector XYZ” at the “Normalisation variable” menu.
3. Click Start.
4. Figure 40 should appear.

Repeat the same steps, but this time choose “Turbulent kinetic energy” at step 2, to obtain Figure 41.
NOTE: The Results, Wind Resources and Energy modules are totally separated and independent from each other, therefore it is not necessary to run them sequentially. If, for example, you need to obtain the AEP from the Energy module, you just can only run the Energy module and it is not needed to run Results and Wind Resources first.

![Properties panel, Results module, extraction of Turbulent kinetic energy](image)

Run the module. Inspect the report, the velocity vector, and the turbulent kinetic energy for all 12 sectors are available as shown in Figure 38 and Figure 39.

NOTE: The height for the extracted results has been set to the default value of 50 m above ground level. Typical heights of interest are the turbine hub height and the height of the wind measurements.

NOTE: That the default legend setting of 0;0 sets the minimum and maximum values found in each extracted dataset as legend limits. This limit has been reset for the turbulent kinetic energy in Figure 39. This is done to better explore details in the results as seen in Figure 41.

It is important to note that the Results module is a tool for visualization of the wind field simulations. This is to observe how the flow fields are affected by the terrain. The wind speeds are not by default calibrated with the wind measurements. Non-dimensional, normalized plots are also available. Then you need to choose the desired normalization type in the property grid. The Wind Resources and Energy modules are used to weight the wind database against the climatology data.
Figure 40 - Results > Report. Wind velocity 3D (m/s) for sector 330° at 50 m a.g.l.
Wind Resources

The Wind Resources module is used to create wind resource maps at chosen heights.

At least one visible climatology must exist in the current layout before running the Wind Resource module. All sectors defined in a given climatology must exist in the wind database. The wind resource map is established by weighting the wind database against the climatology. If several climatology objects are available, the wind resource map will be weighted against all of them. This is done by an inverse distance interpolation of the climatology objects.

Run the module to create a wind resource map for the Hundhammerfjellet project at 50 and 80 meters height with the properties given in Figure 42.
Tutorial Project: Hundhammerfjellet

Figure 42 - Properties panel of the Wind Resources module.

**NOTE:** Results are not very accurate because of the limited size of the computational model WindSim EV which is currently running.

![Climatology Panel](image)

Figure 43 - The wind resource map which is the 2D mean wind speed at 50 m a.g.l. weighted against all climatologies.
Wake Modeling

If the user is concerned about wake losses in the wind farm (also known as wind park effect), one of the 3 wake models can be activated. These wake models can be used both in the module Wind Resources, and Energy. A complete description of the models is provided in the description page of the Wind Resources module.

1. In the “Properties” frame, select “Wake Model 1” at the “Wake model” drop-down menu.
2. Re-run the simulation by clicking the “Start” button. The wake deficits obtained with wake model 1 at hub height are plotted in Figure 44.

![Wake deficit at hub height, wake model 1.](image)

Energy

The annual energy production, AEP, is the most important parameter to be estimated in most wind farm micrositing projects. For a given wind condition, the available power is proportional to the third cube of the wind speed. This means that an uncertainty in wind prediction is
largely increased when computing the available power; so high quality wind modeling is particularly appreciated within micrositing.

Run the module with the default settings and get the annual energy production for each turbine and for the whole wind farm.

![Properties panel for the Energy module, default settings.](image)

For each climatology object, two AEPs are given in the Energy report.
- The first one is obtained from the frequency table of the climatology files
- The second is obtained by Weibull fitting the histogram of frequencies.

An estimate of the energy production is also given by interpolating all visible climatologies. If the *Energy module* with an enabled wake model is re-run, the user can estimate the AEP corrected with wake losses as seen in *Figure 46*.

In order to estimate the corrected AEP you have to switch the “Wake model” option from “Disregard wake” to “Wake Model 1” and re-run the simulation. The introduction of Subsectors and Influence range is in order to reduce the computational resources required for the computation.
Figure 46 - Energy report. Wake losses computed with wake model 1. For more information concerning the AEP you can click on any Climatology or Gross AEP number on the table.

**A Grid Sensitivity Study**

Referring to the AEP forecasted in the exercise a large difference can be noted in the AEP predicted by the two climatologies, approximately 9 GWh/year.

Large parts of the discrepancy observed in the two predictions comes from the fact that this exercise was run with WindSim EV, where there is a limit of 5000 cells; discretization errors are therefore considerable. A typical procedure followed in CFD computations is to continuously refine the grid in order to minimize the discretization errors. The ideal situation is achieved when the errors are negligible, i.e. when *grid independency* has been reached.

In the following Figure the effects of grid sensitivity study on the AEP is given, obtained with the grid refinements shown in the below table.

<table>
<thead>
<tr>
<th>N</th>
<th>Nx</th>
<th>Ny</th>
<th>Nz</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 370</td>
<td>23</td>
<td>19</td>
<td>10</td>
</tr>
<tr>
<td>24 320</td>
<td>38</td>
<td>32</td>
<td>20</td>
</tr>
<tr>
<td>90 280</td>
<td>74</td>
<td>61</td>
<td>20</td>
</tr>
<tr>
<td>375 000</td>
<td>150</td>
<td>125</td>
<td>20</td>
</tr>
<tr>
<td>750 480</td>
<td>212</td>
<td>177</td>
<td>20</td>
</tr>
</tbody>
</table>
Figure 47 - Number of cells in models used for grid independency tests

<table>
<thead>
<tr>
<th>Climatology</th>
<th>Distribution</th>
<th>Gross AEP</th>
<th>Wake loss %</th>
</tr>
</thead>
<tbody>
<tr>
<td>Climatology1</td>
<td>Frequency table</td>
<td>159.2292</td>
<td>-</td>
</tr>
<tr>
<td>Climatology1</td>
<td>Weibull distribution</td>
<td>159.4079</td>
<td>-</td>
</tr>
<tr>
<td>Climatology2</td>
<td>Frequency table</td>
<td>140.0524</td>
<td>-</td>
</tr>
<tr>
<td>Climatology2</td>
<td>Weibull distribution</td>
<td>140.1058</td>
<td>-</td>
</tr>
<tr>
<td>All</td>
<td>Frequency table</td>
<td>145.7715</td>
<td>-</td>
</tr>
<tr>
<td>All</td>
<td>Weibull distribution</td>
<td>148.8663</td>
<td>-</td>
</tr>
</tbody>
</table>

Table 1. Energy production in GWh/yr based on climatology represented by the frequency table and by the Weibull distribution.

<table>
<thead>
<tr>
<th>Air density (kg/m³)</th>
<th>Wake model</th>
<th>Multi-wakes model</th>
<th>Roughness Amb. (%)</th>
<th>Turb. Int. (%)</th>
<th>Sub-sectors</th>
<th>Influence range (Rotor diameter)</th>
</tr>
</thead>
<tbody>
<tr>
<td>No correction</td>
<td>0</td>
<td>2</td>
<td>Variable</td>
<td>5</td>
<td>1.0 - 50.0</td>
<td></td>
</tr>
</tbody>
</table>

Table 2. Site and wake characteristics.

Figure 48 - Report panel for the Energy module, Hundhammerfjellet project (~5 000 cells).

<table>
<thead>
<tr>
<th>Climatology</th>
<th>Distribution</th>
<th>Gross AEP</th>
<th>Wake loss %</th>
</tr>
</thead>
<tbody>
<tr>
<td>Climatology1</td>
<td>Frequency table</td>
<td>152.9213</td>
<td>-</td>
</tr>
<tr>
<td>Climatology1</td>
<td>Weibull distribution</td>
<td>153.0664</td>
<td>-</td>
</tr>
<tr>
<td>Climatology2</td>
<td>Frequency table</td>
<td>140.9978</td>
<td>-</td>
</tr>
<tr>
<td>Climatology2</td>
<td>Weibull distribution</td>
<td>141.0464</td>
<td>-</td>
</tr>
<tr>
<td>All</td>
<td>Frequency table</td>
<td>145.1288</td>
<td>-</td>
</tr>
<tr>
<td>All</td>
<td>Weibull distribution</td>
<td>145.2123</td>
<td>-</td>
</tr>
</tbody>
</table>

Table 1. Energy production in GWh/yr based on climatology represented by the frequency table and by the Weibull distribution.

Figure 49 - Report panel for the Energy module, Hundhammerfjellet project (~25 000 cells).

<table>
<thead>
<tr>
<th>Climatology</th>
<th>Distribution</th>
<th>Gross AEP</th>
<th>Wake loss %</th>
</tr>
</thead>
<tbody>
<tr>
<td>Climatology1</td>
<td>Frequency table</td>
<td>146.8367</td>
<td>-</td>
</tr>
<tr>
<td>Climatology1</td>
<td>Weibull distribution</td>
<td>146.9455</td>
<td>-</td>
</tr>
<tr>
<td>Climatology2</td>
<td>Frequency table</td>
<td>146.6540</td>
<td>-</td>
</tr>
<tr>
<td>Climatology2</td>
<td>Weibull distribution</td>
<td>146.7458</td>
<td>-</td>
</tr>
<tr>
<td>All</td>
<td>Frequency table</td>
<td>146.6858</td>
<td>-</td>
</tr>
<tr>
<td>All</td>
<td>Weibull distribution</td>
<td>146.7840</td>
<td>-</td>
</tr>
</tbody>
</table>

Table 1. Energy production in GWh/yr based on climatology represented by the frequency table and by the Weibull distribution.

Figure 50 - Report panel for the Energy module, Hundhammerfjellet project (~100 000 cells).
<table>
<thead>
<tr>
<th>Climatology</th>
<th>Distribution</th>
<th>Gross AEP</th>
<th>Wake loss %</th>
</tr>
</thead>
<tbody>
<tr>
<td>Climatology1</td>
<td>Frequency table</td>
<td>149.0998</td>
<td>-</td>
</tr>
<tr>
<td>Climatology1</td>
<td>Weibull distribution</td>
<td>149.2445</td>
<td>-</td>
</tr>
<tr>
<td>Climatology2</td>
<td>Frequency table</td>
<td>147.3412</td>
<td>-</td>
</tr>
<tr>
<td>Climatology2</td>
<td>Weibull distribution</td>
<td>147.4403</td>
<td>-</td>
</tr>
<tr>
<td>All</td>
<td>Frequency table</td>
<td>147.9218</td>
<td>-</td>
</tr>
<tr>
<td>All</td>
<td>Weibull distribution</td>
<td>148.0365</td>
<td>-</td>
</tr>
</tbody>
</table>

Table 1. Energy production in GWh/y based on climatology represented by the frequency table and by the Weibull distribution.

Figure 51 - Report panel for the Energy module, Hundhammerfjellet project (~400 000 cells).

<table>
<thead>
<tr>
<th>Climatology</th>
<th>Distribution</th>
<th>Gross AEP</th>
<th>Wake loss %</th>
</tr>
</thead>
<tbody>
<tr>
<td>Climatology1</td>
<td>Frequency table</td>
<td>149.5149</td>
<td>-</td>
</tr>
<tr>
<td>Climatology1</td>
<td>Weibull distribution</td>
<td>149.6543</td>
<td>-</td>
</tr>
<tr>
<td>Climatology2</td>
<td>Frequency table</td>
<td>147.0314</td>
<td>-</td>
</tr>
<tr>
<td>Climatology2</td>
<td>Weibull distribution</td>
<td>147.1283</td>
<td>-</td>
</tr>
<tr>
<td>All</td>
<td>Frequency table</td>
<td>147.8624</td>
<td>-</td>
</tr>
<tr>
<td>All</td>
<td>Weibull distribution</td>
<td>147.9743</td>
<td>-</td>
</tr>
</tbody>
</table>

Table 1. Energy production in GWh/y based on climatology represented by the frequency table and by the Weibull distribution.

Figure 52 - Report panel for the Energy module, Hundhammerfjellet project (~800 000 cells)

The AEP calculated with the five different models is summarized in Figure 53. Important discretization errors are present when WindSim EV is used (~5000 cells). Considering a grid independency reached with a model of 800 000 cells, a model comprising just 5 000 cells gave errors of 20 % for one of the climatology data. The model of size 100 000 cells provided a good estimation of the AEP, the errors could be considered within 3%; considering a grid independency reached with 800 000 cells.

It’s important to stress that the characteristics of a grid which is leading to grid independency is its resolution. So, for wider areas, a higher number of cells are required to minimize the discretization errors.
Figure 53 - AEP for the two climatologies against number of cells used in the 3D models.
Configure Particle Traces in GLview Pro

Generation of the Wind Visualization File

How to generate a 3D wind visualization file (.vtf) in the menu“3D Visualization” is shown below;

Figure 54 - The .vtf file is generated from the 3D Visualization menu on the toolbar

The generated .vtf file must contain the 3D velocity vector, which is the vector field used to establish the particle traces.

1. Click 3D Visualization > Generate 3D wind visualisation file (.vtf). A DOS pop-up window will appear.
2. Type “l” to choose from the list of sectors.
3. Choose the sector 000 by simply pressing “000”.
4. Type “1” to transfer the default variables to the .vtf file.
5. Open the 3D Visualization file by clicking 3D Visualisation>Open 3D wind visualization file (.vtf)... and then selecting the 000.vtf file.

Activate the VELOCITY_3D as vector by pressing the “Apply” button as shown in Figure 55. The max and min values of the chosen scalar and vector fields will appear in the blue info window in the lower right corner;
Configure Particle Traces in GLview Pro

Figure 55 - Set Vector to VELOCITY\_3D and hit Apply in the dialogue box to the bottom left in the screen above

**Setting the Attributes**

Zoom in towards the terrain of the model, as shown below. Rotate the model by using the right mouse button. Then set the attributes of each part in the “Change Part Attributes…” window found under “Model”

Then the grid has to be set invisible first by choosing “grid” and then unselecting the attribute “Visible”. Finish the process by pressing the “Apply” button.
In the **Change Part Attributes** the default setting of all parts which is “Visible” and “Outline mesh” could be reset. Selecting all parts is done by clicking on the first part, while holding down the shift key clicking on the last part.

While all parts are selected, uncheck the “outline mesh” box and check “smooth shading” to give a better visual appearance (see Figure 56).

![Figure 56 - Configure the view to display the relevant parts](image-url)
Configure Particle Traces in GLview Pro

Figure 57- Perfecting the visualization to your projects specific requirements is easy in WindSim!

Creating the Particle Traces

Before calculating particle traces you need to define the start positions for the traces. Each trace represents the path of an artificial particle without mass following the wind field in a passive manner. In order to get a good representation of the wind field it is convenient to specify many traces. This is done by specifying the start positions within a box, with a given number of start positions in x, y, and z direction. To open the window “Particle Traces” click Vector > Particle Tracing… (see Figure 58). The dimension of the box will be model dependent. In the model below the box is positioned towards the North border as the wind field with incoming wind from North has been loaded (000.vtf).

The coordinates (X1,Y1,Z1) and (X2,Y2,Z2) represent the front left bottom point and the far upper right point respectively. In order to specify the dimensions of the box, you need to set these coordinates and then click “Apply” (see Figure 59).
Figure 58 - Open the dialogue box from the Vector menu on the toolbar

Figure 59 - Replicate the settings above to achieve the same particle traces

Under the folder “Options” the user can set the direction for the calculation of the traces. In the given case the calculation is only done forward, as the box with starting point is put near the inlet border therefore the traces will pass through most of the model.
Configure Particle Traces in GLview Pro

In some cases the default method for integrating the paths, the Euler method, will fail. If the traces do not follow the terrain, but appears like straight lines pointing towards the sky, then it is recommended to switch to the linear integration method.

![Image of GLview Pro interface](image)

**Figure 60 - Set the direction of your particle traces**

**Animating the Traces**

From the window “Particle Trace” the folder “Startpoint” should be chosen. Then by choosing the “Display Setup” button in the upper right corner the window “Particle Trace Display Setup” will open.

The setting for animating the particles are set in this window.

- Check the box “Animate” to unlock the animation options.
- Check the box “Incremental trace”
- Uncheck the box “Complete trace”
- Press the “Apply” button.

Try to animate using line (worm) by check the box “Tail”. Play with the settings and see what works for your model.
The user has full control over the simulation parameters to design an animation to suit any project requirements.

**Textures**

The final touch for your presentations is obtained by adding textures. Textures could be added to the different parts. For example adding a satellite photo or a scanned map to the DTM (Digital Terrain Model) would make it easier to recognize locations in the model. The only purpose of the cylinder surrounding the model is to add a “sky texture”.

You can find Sky Textures at windsim.com under “Library” on the menu bar.

A texture is added to a part using the “Change Part Attributes” window introduced above. Select the part and then click the button “Texture...”. In the “Texture Settings For Part(s)” window, a picture must first be loaded and then this picture must be pasted over the part from a given direction, defined by the “Plane”. The picture is stretched over the part if the box “Clamp” is checked. Otherwise a tile pattern is generated.
Configure Particle Traces in GLview Pro

Figure 62 - Adding a sky texture greatly enhances the quality of the visualization

Save and Share

When you are satisfied with the setting, you can save all the settings to a new .vtf file in the menu “File” – “Export to File” – “VTF File...”. Send us your .vtf file and we will publish it at windsim.com on our 3D Visualizations page. A .vtf file can be visualized in the free viewer GLview Express found on the above web page.

Figure 63 - Just one example of the infinite customizability of WindSim visualization
Configure Isosurfaces in GLview Pro

Generation of the Wind Visualization File

Generate a 3D wind visualization file (.vtf) in the menu "3D Visualization" following the same procedure as in paragraph “Configure Particle traces in GLview Pro” at page 48.

The generated .vtf file must contain the 3D velocity vector, which is the vector field used to establish the particle traces. Moreover, the .vtf has to contain the scalar variable that has to be plotted as isosurface.

Open 3D Visualization file

Open the 3D wind visualization file (.vtf) in the menu 3D Visualization. Activate SPEED_2D as Scalar by pressing the button “Apply”, then the min and max values of the chosen scalar fields will appear in the blue info window in the lower right corner (see Figure 65).
Configure Isosurfaces in GLview Pro

58

Setting the Attributes

Zoom in towards the box and rotate the model by using the mouse buttons. Then set the attributes of each of the parts in the “Change Part Attributes” window found under “Model” – “Change Part Attributes…”. First the grid has to be set transparent by selecting the grid and check the attribute “Transparent” then press the button “Apply” (see Figures 66 and 67); then the transparency level has to be put to the maximum value (0.0), click on the Material button to set the transparency to 0.0 as shown in Figure 68, then click on OK and Apply to confirm.
Creating the Isosurfaces

Select the "Isosurface..." option under the Scalar menu (see Figure 69). Select the value of the loaded scalar that you want to display and press Apply, as shown in Figure 70. Rotate and zoom with the mouse to obtain a good view of the flow field.
Configure Isosurfaces in GLview Pro

Figure 69 - Open the Isosurface dialogue box from the Scalar menu

Figure 70 - The above value generates a nice plot for the Hundhammaren project

Figure 71 - The Isosurface is now displayed relative to the terrain to visualize the flow in the wind farm

Textures - Save and Share

For adding textures and sharing data with others see the procedures described in the above section "Configure Isosurfaces in GLview Pro".
Figure 72 - A texture adds a nice touch to the graphics for use in presentation and reports!
Add-on Module: Terrain Editor

The WindSim Terrain Editor functions as a separate application and allows you to efficiently load and prepare terrain and roughness data from a variety of sources. You can load terrain and roughness data, georeference photographs for backdrops, digitize and save roughness features, utilize advanced datasets such as canopy height and then export the data directly into the WindSim format.

**New Project**

You can start the WindSim Terrain Editor from inside WindSim or from the Start menu.

When you start Terrain Editor from **Tools > Terrain Editor**... the window below will appear.

Please choose the image for your area. If you don’t have an image, press cancel and a blank image is used. The digital terrain model (.gws file) used for the project is the same as your current WindSim project.

![Add map image](image)

*Figure 73 - Locate an image of the area in the project you have opened in WindSim.*

Starting the application from the Start menu opens the program with no files loaded. You then start a new project from the File menu and load the necessary files as shown below:
Figure 74 - Creating the new project and loading the terrain height and background photo. Main path is: C:\Program Files (x86)\WindSim\WindSim 9.0.0\Data. The terrain can also be left blank here and then imported via the Tools menu, along with separate files for roughness height or canopy/vegetation height.

After this initial step, the procedure is the same regardless of how you opened the Terrain Editor.

**Georeferencing**

When you have loaded the image, you must specify 3 coordinates to be able to georeference the image. Place these 3 GCPs (Ground Control Points) using the toolbox as shown below. Simply click the symbol shown below in the toolbox and then click on the image where you want to specify the coordinates. This x- and y-coordinate must be the same format as specified in your terrain model (.gws file)
Add-on Module: Terrain Editor

Figure 75 - Press the button illustrated above to place the GCPs.

In this example we use three points at the edge of the domain. For each GCP the user specifies these known coordinates in the properties section.

Figure 76 - For each GCP, the user must specify the real coordinates in the Properties pane in the lower right of the Terrain Editor window.

You click with the mouse into the lower left corner and enter 322950 and 7182475 as coordinates. After that you click into the lower right corner and enter 332000 and 7182475 and then you click into the upper right corner and enter 332000 and 7190025 as coordinates. When all coordinates are defined, click on the globe icon in the toolbox as shown below to geo reference your image.
Figure 77 - The far right icon finalizes the geo-referencing process.

Please wait while the georeferenced image is redrawn.

Figure 78 - Depending on the speed of your system and the size of the image file, you might have to wait for a few minutes while the image is georeferenced.

When the geo-referencing is completed, you will be able to see your image together with the digital terrain module. Use the “Height” and “Roughness” scrollers to adjust the transparency.
Add-on Module: Terrain Editor

of the height and roughness layers. You can now verify visually that the terrain module matches your image.

![Image of Terrain Editor interface]

**Figure 79 - Changing the transparency of the different layers help you verify that the changes you are making are correct.**

**Draw roughness**

You can now draw additional roughness polygons with the drawing tool. The roughness you draw will overwrite existing roughness from the digital terrain model in the area bound by the edges of the polygon.

1. To draw a new polygon select the “Draw roughness” icon from the Toolbox.
2. Select the corners of each polygon.
3. After you have finished drawing, right-click anywhere on the screen to confirm.
4. Specify the roughness height for the area in the Properties window.
5. If you want to delete your polygon, choose the “Select” icon from your Toolbox, click on the polygon and press *delete* on your keyboard.
6. Repeat the steps 1 to 3, to draw another polygon.
Figure 80 - Click the second icon from the left to draw customized, detailed roughness descriptions based on images of your site.

When the drawing is ready you must merge them with the existing roughness dataset using: 
**Tools -> Merge roughness layers.** Your drawings will overwrite exiting roughness.

Figure 81 - Merge roughness commands brings all roughness into one layer.
To see the newly created terrain image, export it and then re-open it. Notice that WindSim will not allow you to export the terrain file in the current project.

**Export**

You can export the map image to a .bmp file with **Export -> Export map image**

![Export map image](image1)

You can export the dataset to a new .gws file with **Export -> Terrain (.gws)**

![Export terrain (.gws)](image2)

When working with a Terrain Editor project the terrain dataset is stored in a separate .gws file in the same folder as the project .wspdb file. When you save your work, the .gws file is updated.

**Undo/Redo**

It’s possible to undo/redo your last changes. Select from Edit->Undo/Redo, or using shortcuts.

![Undo/Redo](image3)

**Change map image**

You can change the background image by right clicking the existing image name and then Change image.
Add-on Module: Remote Sensing Correction Tool

The Remote Sensing Correction Tool corrects LIDAR measurements. It uses the LIDAR 10 minutes averages. The method is using the vertical wind speed variation calculated by WindSim to correct the LIDAR measurements. LIDAR systems use the assumption of a homogeneous wind field for converting the measured radial wind speed into horizontal wind speed. In complex terrain this assumption is not valid and a correction is necessary.

The Terrain module used for the Remote Sensing Correction Tool should be built after the following rules:

**Vertical resolution**
- The vertical resolution should be around 10m up to the highest measurement height of the LIDAR. This might be achieved by using a refinement file and using more than one height distribution factor in the vertical.

**Horizontal resolution**
- The horizontal resolution should be in the range of 10 m. This allows modeling an area of 4x4km with the current WindSim version which is considered suitable.

**Terrain Smoothing Limit**
- The simulation should be run without smoothing to guarantee that the vertical wind speeds are simulated in the right way.

**Orthogonalization of the Grid**
- This option should not be used to make the extraction of the results possible.

**Forests**
- Can be used as an option.

**Nesting**
- Might be considered if the complexity of the site makes it necessary to take into account mesoscale effects.

The Remote Sensing Correction Tool can be started from the Tools menu in WindSim.
**Add-on Module:** Remote Sensing Correction Tool

**Figure 82- Opening of the Remote Sensing Correction Tool.**

A dialogue will pop up where the specifications of the LIDAR have to be set.
Data files
The sta files (LIDAR 10 minutes data) are often delivered on a daily basis. For the correction period they have to be merged into one single file with one header. A routine for that can be found under the installation folder of WindSim (bin/Modules/RemoteSensingCorrectionTool). The executable “cat_together_ststa.exe” should be copied and executed in the folder where all daily .sta files are stored. This folder should not contain sub folders. The resulting input.sta data file is then the file which should be used for the correction. The single .sta data files have to be in ascii format. A conversion routine from binary to ascii format can be obtained from Leosphere if it is necessary.

Angles
The scan angle and the direction offset angle are given in the header information of the sta file.

Levels
The measurement heights have to be given here. They can be found under “Altitudes” in the header of the LIDAR files. All heights have to be specified. The corrected measurements can be written in .tws format that they are easily usable in WindSim. You can specify the levels for which you want to write out the .tws files.

Position
The position of the LIDAR can be given either in global or in local coordinates

Wind Field
The number specifies which sectors are used for the LIDAR correction. The sectors are calculated by the following formula: INT(360/number). You need to make sure that these sectors have been run successfully in the WindSim project otherwise the correction will fail. In case of difficult terrain it is of advantage to use more than the standard of 12 sectors.

Output
The corrected LIDAR data can be exported directly to WindSim's tws format and used as a climatology in a WindSim project. Beside of this a file is written which contains the corrected wind speed for all measurement heights.

Data Filtering
Add-on Module: Remote Sensing Correction Tool

The 10 minutes LIDAR data have been filtered by Leosphere already and no further correction is necessary.

After all fields have been filled in correctly press the "NEXT" button. The correction will be started and may take up to one hour to complete. The result file can be found under the climatology folder of the project which is used for the correction.
Add-on Module: Forecasting

The Forecast Application 1.0 is handling the set up and operation of a wind power forecast on an existing wind farm. The application permits to use a hybrid solution of deterministic and statistical tools for that purpose.

In particular it uses Artificial Neural Networks (ANN), Computational Fluid Dynamics (CFD) and wake effect calculation to get the power forecast. A complete WindSim CFD project has to be run on the wind farm before the Forecast Application 1.0 can be used. The application has to refer to this existing WindSim CFD project.

The add-on module has the basic features of our forecasting system. During 2015 we will launch a web portal which will give the user access to all forecasting features developed so far.

Basic ideas

The usage of CFD in wind power forecasting is a complex problem. CFD is used to downscale results from Numerical Weather Prediction models (NWP) to the turbine positions and those models may have different boundary conditions, physical descriptions of the atmosphere and outputs.

The main focus is how to downscale the NWP results with the CFD model and to make the wind power forecast from these results.

The solution we are using is quite simple but at the same time very effective. We use the observed data from an anemometer to transfer the NWP results via ANN to the anemometer position and from there we move the results in the space to the turbine positions using the WindSim power calculation based on CFD and wake effect simulations (Fig 84).

Figure 84: Downscaling of NWP results to the turbine positions. The red arrow shows the ANN which transfers NWP result to the anemometer position. The blue arrows show the downscaling via the CFD model and the wake correction calculation.
The CFD downscaling and the wake calculation are performed by the WindSim software. All the settings related to them have to be set previously in the WindSim project and are inherited by the Forecast Application.

The main goal of the Forecast Application is to manage the connection with a forecast NWP source, perform the ANN correction to it, run the WindSim energy calculation and provide the results.

**NWP forecasts**

NWP model is a general definition of a model which predicts atmospheric conditions globally or in a certain area. Usually the NWP model runs are performed by the customer or by a third party.

From these models a forecasted time series from a model grid point inside the WindSim project area can be extracted and used in the forecasting system. The selected grid point should be close to the wind park.

The connection with the forecast application can be done by connecting it to a FTP area where new forecasting time series from the NWP are provided in a local folder. The forecast application will check the FTP looking for a file with a defined name and if that file is newer than the last ingested file the application will start to perform the new forecast automatically using that file as input.

The steps performed on it are:

1. Read the new file (if in a different format, convert to ".tws" format)
2. Perform a ANN correction and transfer the data to the anemometer position (if it is set true)
3. Set the new ".tws" as climatology in the forecasting layout
4. Run the energy module and do the power forecasting export
5. Display the obtained forecasted power
6. Store the forecasted power ".dat" file in the Forecast(Layout)/forecast folder

It is possible to avoid the ANN correction and ingest the NWP time series directly in the original position. Some users can provide already ANN corrected data or may want to use directly the raw NWP output.

**Forecast Application**

The forecast application provides a user friendly interface for the flow chart described in figure 85. It is divided into two parts: Set-up period and forecasting mode.

The set-up period is mainly the ANN training phase. The training is performed using historical forecast data (Hindcasts) and historical observed data.
Normally the training is performed once. Different setting can be used to get the best performance. A new training can be performed each 6 month/every year adding the latest data available, both new forecasts and new observed data.

In the training the ANN finds connections and relations between the NWP data and the observed data storing it in a compact tool. ANN can be considered as a black box that learns how two time series are related in the training period and then use these relations to correct NWP forecasted time series before usage.

In the training it is really important to provide to the ANN data sets that are clean of icing periods, periods with damaged instruments or any other bad quality data.

The forecasting mode uses the ANN correction on the new forecasted time series to transfer them from the NWP forecasting point position to the anemometer position. After that the time series are transferred to every turbine position using the CFD results. After the wake calculation the energy calculation is performed for every turbine. Thanks to the speed of the ANN correction this process takes only seconds.

The complete description of the forecasting tool can be found in the document. WindSim_Forecasting_Application_1.0.docx.

Figure 85: WindSim Forecasting 1.0. The parts in blue take place inside the WindSim software. The input data necessary for the training of the neural networks is displayed in orange.
Add-on Module: Park Optimizer

The park optimizer is taking the WindSim simulation results and calculates an optimized layout based on the wind resources, the wake effects and given constraints. The program has an extensive help documentation such that only the input and the basic functionality are described hereafter.

WindSim needs to be run until the wind resource module. In the results module different variables need to be extracted in 3 different heights which equal the lower and upper tip height and the hub height: speed scalar XY, speed scalar Z, inflow angle, and turbulent intensity.
In the wind resource module the Export to wasp format has to be performed for the entire simulation area.

Work steps

After loading the ws file a park area has to be drawn or loaded in (Fig. 86). This can be done by clicking on the “Figure” button on the right hand side.
Areas where turbines cannot be built can be excluded by different IEC criteria: *Wind shear*, *Inflow angle*, *Terrain inclination*, *Turbulence*, and *Extreme speed*. The values can be entered when clicking the button “IEC Constraints” (Fig. 87). Also restricted areas e.g. lakes and buildings can be specified via a shape file. The excluded areas where no turbines can be build are shown in grey.

The optimal turbine positions are calculated given the maximum and minimum amount of turbines and the minimum distance of the turbines (Fig. 88). Unlike the heuristic algorithms, the new method will give a new layout for each new turbine added. The wake effects can be taken into account using different techniques which are further explained in the help document of the program.
The park layout can be optimized from an economic point of view and the Net Present Value can be calculated (Fig. 89). Giving the costs of the turbines it can be seen how many turbines in the wind park will give you the best benefit.